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Intfroduction

Creating forms for your database can make entering
data more convenient. When you create a form, you
can design it in a way that works with your database
and that makes sense to you.

= In this lesson, you will learn how to create and modify
forms. You'll also learn how to use form options like
desi controls and form properties to make sure
your form works exactly the way you want.




Create a form

ccess makes it easy to create a form from any table in your

atabase. Any form you create from a table will let you view
the data that's already in that table and add new data.
Once you've created a form, you can modify it by adding
additional fields and design controls like combo boxes.

vigation pane, select the table you want to use
te a form. You do not need to open the table.

the Form command.

External Data Database Tools Design Arranc

Dm D ’ﬁ\m GDDFOFmeard |

=1 Navigation ~

Application Table Table SharePoint Query Query Form Form Blank
Parts ~ Design Lists ~  Wizard Design % Design Form EIMore Forms -

Templates Tables Queries Forms



Create a form

. Your form will be created and opened in Layout view.

‘IE Customers1 | |=8] Orders

1 Customers

ID | Email beck@email.com

Search v

Other Notes

First Name Tracey Phone Number 919-555-2314
Last Name Beckham City Raleigh
Add to Mailing List? |No .
Street Address 7 East Walker Dr. Combol I ] "
State NC Other Notes
Zip Code 27612
ID 7 Paid ~ Pre Order - Notes ~ Pickup Date -~
* 38 Yes No 12/24/13

* (New) No No




Create a form

4. To save the form, click the Save command on the Quick
Access Toolbar. When prompted, type a name for the
form, then click OK.

Save As ? X

Form Name:

Customers Form| I




About subforms

If you created a form from a table whose records are
inked fo another table, your form probably includes
a subform.

A subform is a datasheet form that displays linked records
in a table-like format. For instance, the subform included in
the Customers form we just created displays linked
custoner orders.

robably don't need to include this subform because
we/iustiwdnt 1o ‘Use! the. Cusiomets form:fo.enler iand
reyiew contact information. If you find that you don't need
a/subform, you can easily delete it. To do this, simply click
If and press the Delete key on your keyboard.



About subforms

=8| Customersi \'-\

Customers
5 \

| Street Address 7 East Walker Dr. Add to Mailing List? | No

State NC Other Notes

 Zip Code 27612

r

: ID 7 Paid * | Pre Order - Notes = Pickup Date -
: 38 Yes No 12/24/13
| (New) No No

| [Record: 4 b oM No Fier




About subforms

However, subforms are often quite helpful. Depending on the
content,/and source of your form, you might find that the
subform contains useful information, like in the example below.
In our Orders form, the subform contains the name, quantity,

and price of each item contained in the order, which is all useful
information.
=New Order
Customer Whitman v| Order# |5 Pickup Date |12/4/13
Notes [1Pre Order
[ Paid
=Add ltem
Category - Product * Quantity = "Unit" =~ Price -1 Subtotal - =
Cookies Chocolate Chip 2 Single $1.50 $3.00
Cookies Fudge Brownie | Single $2.00 $2.00
Cookies Ginger Shortbread | Half-Dozen $10.50 $10.50
Pastries Brownies | One Dozen $19.00 $19.00
Cakes Black Forest 5 Single $22.00 $110.00
Cakes Coconut 2

$22.00 :




B Add a fleld to a form

Select the Design tab, then locate the Tools group on the
right side of the Ribbon.

Click the Add Existing Fields command.

The Field List pane will appear. Double-click the desired
field(s).

Field List *

i Q A A - =
Design Arrange Format v/ Tell me what you want to do Olenna Mason , E- Show all tables

= [El \/ M‘ : [#i?eo E‘D Fields available for this view:
' © e Fomeanatine AOEEGRTERY 0
Controls Header / Footer Tools ~ B First Name
" : : : Last Name
Street Address
State
Zip Code
Email

Phone Number
City

Add to Mailing List?
Other Notes %




Add a field to a form

4. The field will be added.

—1 Customers

,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,
11D | Email beck@email.com

Other Notes

First Name Tracey Phone Number 919-555-2314

Last Name Beckham City Raleigh

agdd the desired fields.

External Data Database Tools Design Arrang
"% Form Wizard
=S [ RS BB
e et W

: o Navigation ~
Table Table SharePoint Query Query Form Form | Blank

Design Lists ~  Wizard Design Design FormMore Forms - §

Tables Queries Forms




Add a field from a different table

ou can also add fields from
ifferent tables in your database
fo the form.

1. From fthe Field List pane,
click Show All Tables.

2. Click the plus sign + next to

the table that contains the

field you want to add, then

double-click the desired

field. The new field will be
dded.

Fie
EI-

Fields

ld List

Show all tables

available fnrg ]uiew:

|

Field List x B

Er Show only fields in the current record
source

Fields available far this view:
El Customers Edit Table |«

D

First Mame

Last Mame

Street Address

State

Zip Code

Email

Phone Mumber

City

Add to Mailing List?

Other Motes

Add to Mailing List

Field1 v B

Fields available in related tables:
E Orders Table Edit Table | «
D
Customer ID I}
Faid
Pre Crder
Motes

Pirkun Nate



Adding design confrols : Combo boxes

A combo box is a drop-down list you can use in your form
in place of a field. Combo boxes limit the information users
can enter by forcing them to select only the options you
have specified.

» Combo boxes are useful for fields that have a limited
number of possible valid responses. For instance, you
might dse a combo box to make sure people only enter @
valid/MU.S. state while entering an address, or that they only
chgose products that already exist in your database while
pldcing an order.




Create a combo box

In Form Layout view, select the Design tab, then locate
the Controls group.

. Select the Combo Box command, which looks like a
drop-down list.

Arrange Format  Q Tell me what you want to do... |

> D ] Insert

&§ Image
Controls |

4




Creatfte a combo box
. Select the desired location for the combo box. A line will
appear to indicate the location where your combo box

will be created. In our example, we'll place it between
the City field and the Add to Mailing List? fields.

Phone Number 919-555-2314

City Raleigh

Add to Mailing List? |No =E




Create a combo box

4. The Combo Box Wizard dialog box will appear. Select |
will type in the values that | want, then click Next.

Combo Box Wizard

This wizard creates a combo box, which displays a list of values you

can choose from. How do you want your combo box to get its
values?

I want the combo box to get the values from another table or
query.

I will type in the values that I want.

Find a record on my form based on the value I selected in my
combo box.

Cancel Next >




Create a combo box

Type the choices you want to appear in your drop-down list.
Each choice should be on its own row. In our example, we are
creating a combo box for the Add to Mailing List? field in our
form, so we will enter all of the possible valid responses for this
field. Users will be able to select one of three choices from our

finished combo box: No, Yes - Weekly, and Yes - Special Events
and Offers.

Combo Box Wizard

What values do you want to see in your combo box? Enter the number of columns you want in
the list, and then type the values you want in each cell.

To adjust the width of a column, drag its right edge to the width you want, or double-click the
right edge of the column heading to get the best fit.

Number of columns: ’T

Coll

No

Yes - Weekly
# nts and Offers I
#*




Create a combo box

If necessary, resize the column so all of your text is visible.
Once you are satisfied with your list, click Next.

Combo Box Wizard

What values do you want to see in your combo box? Enter the number of columns you want in
the list, and then type the values you want in each cell.

To adjust the width of a column, drag its right edge to the width you want, or double-click the
right edge of the column heading to get the best fit.

Number of columns: ’T
No

Coll +
Yes - Weekly

es - Special Events and Offer
E =

Cancel < Back Next > Finish




Create a combo box

Select Store that value in this field, then click the drop-
down arrow and select the field where you want
selections from your combo box to be recorded. After
making your selection, click Next.

Combo Box Wizard

Microsoft Access can store the selected value from your combo box
in your database, or remember the value so you can use it later to
perform a task. When you select a value in your combo box, what
do you want Microsoft Access to do?

OBemember the value for later use.

(@) Store that value in this field: | v

ID

First Name
Last Name
Street Address
State

Zip Code
Phone Number

City

Add to Mailing List? * ]

Cancel < Back Next > Finish




Create a combo box

Enter the label—or name—that will appear next to your
combo box. Generdlly, it's a good idea to use the name
of the field you chose in the previous step.

Combo Box Wizard

What label would you like for your combo box?

Add to Mailing List? l

E

; E
Those are all the answers the wizard needs to create your combo

box.

Cancel < Back Einish l.




Create a combo box

Click Finish. Your combo box will appear on the form. If you
created your combo box to replace an existing field, you
should delete the first field. In our example, you might notice
that we now have two fields with the same name. These two
flields send information to the same place, so we don't need
them both. We'll delete the one without the combo box.

Phone Number 919-555-2314
City Raleigh
Add to Mailing List? |No o

Add to Mailing List? ||[No
1

Other Notes



Create a combo box

10. Switch to Form view to test your combo box. Simply click the
drop-down arrow and verify that the list contains the correct
choices. The combo box can now be used to enter data.

Phone Number 9]19-555-23 14
City Raleigh
Add to Mailing List? ul

No - :
Vﬂ_‘* - Special Events and Offers :

Other Notes




Create a combo box

% If you want to include a drop-down list with a long list of options
and don't want to type all of them out, create a combo box
and choose the first option in the Combo Box Wizard: | want to
get the values from another table or query. This will allow you to
create a drop-down list from a table field.

Combo Box Wizard

This wizard creates a combo box, which displays a list of values you
can choose from. How do you want your combo box to get its
values?

%I want the combo box to get the values from another table or
query.

(O T will type in the values that I want.

Find a record on my form based on the value I selected in my
combo box.

Search v
Tracey Beckham 919-555-2314 ~
Other Notes Lucinda George 919-555-4534
Jerrod Smith 919-555-4564
Cancel Brett Newkirk k‘ 919-555-7653
— Chloe Jones 919-555-8658
1 Quinton Boyd 919-555-5112
| First Name Alex Hinton 919-555-5460
Nisha Hall 919-555-5753




Customizing form settings with Property Sheet

The Property Sheet is a pane containing detailed
information on your form and each of its components.
From the Property Sheet, you can make changes to every
et ek yoUre o, i Dolhaun: fermsaeb fUnchon=and
appearance.

» The bestway to familiarize yourself with the Property Sheet
is To open it and select various options. When you select
an option, Access will display a brief description of the
opton on the bottom-left border of the program window.




Customizing form settings with Property Sheet

All Ac.. ®@ «

Jo
Parameter Que... |Z|

Search...

73d  Products Query

Forms 3

Customers
Customers Form
Employee Data...

_
Menu Items

Order ltems

Customers‘l\( Orders

1 Customers

B

Search

Other Notes

! First Name

[»] %

Property Sheet
Selection type: Text Box

All

‘ID

Format Data Event Other

Format A

Decimal Places
Visible 1

Tracey

Show Cite Picker
Width

Height

Top

Left

Back Style

Back Color
Border Style
Border Width
Border Color

Special Effect

Scroll Bars

Font Name

Record: M+ 1 of 200 {3 | b-:::-‘

Font Size

ake object visible?




Modifying form setftings

There are far too many options in the Property Sheet to
discuss them all in detail. We'll review two useful ones
here: hiding fields and sefting fields with dates fto
automatically fill in the current date. Practicing these

procedures should also give you a sense of how to work
with other Property Sheet settings.




78 Hide a field

In either Layout or Design view, select the Design ftab, then
locate the Tools group. Click the Property Sheet command.

The Property Sheet will appear in a pane on the right. On the
form, select the field you want to hide. In our example, welll
hide the Customer ID field because we don't want any of our
users to fry to edit If.

Design Arrange Format @ Tell me what you want to do...

@ Logo

| ) B | 5 =

f D . =KV M| =6 O . [ Title L ;

b ='|_| Insert 7% Date and Time AddlEmstlng Property
Image Fields Sheet

Controls Header / Footer Tools

‘E Customers1 | 53] Orders \

" Property Sheet  * |

= Customers Selection type: Text Box
S 1D ~
>
,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,
D | Format Data Event Other All
| +
| MR Visible ~
! Text Format

Datasheet Caption
Show Date Picker
Width

Height

Top

Search

Other Notes




Hide a field

In the Property Sheet, click the All tab, then locate the Visible
option on the fifth row.

Click the drop-down arrow in the column to the right, then
select No.

5. Switch to Form view to verify that the field is hidden.

Property Sheet % k

Selection type: Text Box

h
!
ID v '
Format Data Event Other  All ;
Name 1D A E
Control Source ID i
Format
Decimal Places Auto
Visible | v i
Text Format Yes E‘
Datasheet Caption i
Show Date Picker For dates
Width 3.1514" I
Height 0.6097" H
Top 0.25" 'f
Left 1.6146" i
Back Style Normal
Back Color Background 1
Border Style Solid g

Border Width Hairline
Border Color Backaround 1, Darker 35% Y B

= g T TS L AR R ToLs Lo




Set a field to autofill with the current date

. In either Layout or Design view, select the Design tab, then
locate the Tools group. Click the Property Sheet command.

. The Property Sheet will appear in a pane on the right. On the
form, select the field you want to automatically fill in the current
date. This must be a field with the date data type. For our

exomple}we'll select the Pickup Date field on our Orders form.

‘ % CustomersT. ‘ % Order;.; \

4
X |
Property Sheet
F .
Selection type: Text Box
| Pickup Date v
Format Data Event Other  All
Visible Yes VA
Text Format Plain Text
#### | Pickup Date ) Datasheet Caption
{% Show Date Picker For dates
] Width 0.8333"
Top 1"
[1Paid Left 6.125"
Back Style Normal
Back Color Background 1
Border Style Solid
Border Width Hairline




Set a field to autofill with the current date

In the Property Sheet, click the Data tab, then select the Default
Value field in the fourth row. Click the Expression Builder bufton
that appears in the column to the right.

Property Sheet *

Selection type: Text Box

Pickup Date v

Format Data  Event Other All

Control Source Pickup Date

Text Format Plain Text

Input Mask

Default Value ’7
Validation Rule %
Validation Text

Filter Lookup Database Default

Enabled Yes

Locked No




Set a field to autofill with the current date

. The Expression Builder dialog box will appear. In the Expression
Elements list, click the words Common Expressions.

. In the Expression Categories list, double-click Current Date.

Expression Builder X

Enter an Expression to define the control property value:
(Examples of expressions include [field1] + [field2] and [field1] < 5)

Date() |

Cancel
Help
<< Less
Expression Elements Expression Categories Expression Values
#13 Orders Current Date Date) |
[+® Functions Current Date/Time

LELJ Access2016_SampleDatabase.ac
Constants
% Operators
" Common Expressions




Set a field to autofill with the current date

. The expression for Current Date will be added. Click OK.

Expression Builder

Enter an Expression to define the control property value:
(Examples of expressions include [field1] + [field2] and [field1] < 5)

Cancel

Help

<< Less

Expression Elements

Expression Categories
[+I= Orders

Expression Values

DateQ |
[+}® Functions
Access2016_SampleDatabase.ac
----- & Constants
----- & Operators
~fr Common Expressions

Current Date/Time




Set a field to autofill with the current date

/. Switch to Form view to verify that the expression works. When
you create a new record with that form, the date field you
modified will automatically fill in the current date.

Customer

Notes

=New Order

V| Order # ### Pickup Date [4/1/16

[1Pre Order

[ Paid




Practice

Open practice database.
Create a form from the Customers fable.

Delete the subform.
Create a combo box. Add the following choices to the combo
box:

Raleigh
Durha

Charlotte

Store the value in the City field, and label the combo box NC City List.
Click Finish when you are done with the Combo Box Wizard.

witch to Form view, and click the drop-down arrow in the combo
ox you created. You should see a list of cifies.




TAE END




